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Abstract

This paper describes the use of 18F-FDG and micro-PET/CT imaging to determine in vivo glucose metabolism kinetics in mice (and is
transferable to rats). Impaired uptake and metabolism of glucose in multiple organ systems due to insulin resistance is a hallmark of type 2
diabetes. The ability of this technique to extract an image-derived input function from the vena cava using an iterative deconvolution method
eliminates the requirement of the collection of arterial blood samples. Fitting of tissue and vena cava time activity curves to a two-tissue, three
compartment model permits the estimation of kinetic micro-parameters related to the 18F-FDG uptake from the plasma to the intracellular space,
the rate of transport from intracellular space to plasma and the rate of 18F-FDG phosphorylation. This methodology allows for multiple measures
of glucose uptake and metabolism kinetics in the context of longitudinal studies and also provides insights into the efficacy of therapeutic
interventions.

Video Link

The video component of this article can be found at https://www.jove.com/video/55184/

Introduction

The purpose of this study was to develop a positron emission tomography/computed tomography (PET/CT) based methodology to quantify the
in vivo, real-time uptake of glucose from the blood stream into specific tissues in mice. This was achieved using 18F-labelled fluorodeoxyglucose
(FDG) to measure glucose uptake and kinetic modelling to estimate the rates of 18F-FDG uptake from the plasma to the intracellular space, the
rate of transport from intracellular space to plasma and the rate of 18F-FDG phosphorylation.

In rodents, 18F-FDG has been used in the pre-clinical assessment of numerous cancer treatments1, studies of tumor progression2 and tumor
metabolism3 as well as imaging of brown fat depots4, neuroinflamation5 and brain metabolism6.

Traditional methods used to examine the tissue specific uptake of glucose in mice (and rats) generally involve treatment with 2-deoxyglucose
radiolabeled with either 3H or 14C followed by euthanasia, tissue collection and measurement of radioactivity in each tissue7. The use of PET/
CT allows for noninvasive determination of glucose uptake and metabolism in multiple organs and regions simultaneously in live animals.
Additionally, as euthanasia is not a requirement, this technique is suitable for use in longitudinal studies.

Type 2 diabetes mellitus (T2DM) is characterized by disrupted glucose metabolism and hyperglycemia secondary to reduced tissue
responsiveness to insulin (insulin resistance) and the inability of pancreatic -cells to produce adequate amounts of insulin8. Kinetic analysis of
glucose uptake and metabolism can provide important insights into the mechanism of action and efficacy of therapeutic interventions as well as
allow for advanced monitoring of disease progression.

Protocol

All procedures described in this study were approved by the Sydney Local Health District and University of Sydney Animal Ethics Committees
and followed the NIH Guide for the care and use of laboratory animals, Eighth edition (2011).
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1. Animal Preparation

NOTE: In this protocol male db/db mice (BKS.Cg-Dock7m +/+ Leprdb/J) were maintained in group housing with ad libitum access to chow and
water until 6 weeks of age. At the time of imaging, mice weighed ~ 30 g. All mice used in this protocol had fasting blood glucose levels between
10 and 14 mmol/L.

1. If required, fast the mice. In the present example, fast the mice for 5 h prior to the experimental procedure.
2. Treat mice with the desired agent (e.g. drug, protein, peptide) before the commencement of imaging. In this example, administer a

subcutaneous injection of insulin (3 U/kg human insulin) or equivalent volume PBS 30 min prior to the start of imaging.

2. Set up Workflow

NOTE: This protocol was implemented on a PET/CT scanner. Acquire PET data first, followed by acquisition of CT data.

1. PET settings:
1. Select isotope as 18F, set scan duration to 3,600 s, and upper and lower level energy discrimination to 350 keV - 650 keV (default) with

a coincidence timing window of 3.432 ns (default). Histogram list-mode data into 16 frames (6 × 10 s, 4 × 60 s, 1 × 300 s, 5 × 600 s) for
the period 0 - 60 min after tracer injection. Reconstruct emission sinograms using 2D-FBP with a zoom 1.5.
 

NOTE: The reconstructed images consisted of 16 dynamic frames, each with 128 × 128 × 159 voxels and a voxel size of 0.52 × 0.52 ×
0.796 mm3.

2. CT settings:
1. For a whole body CT scan, set the current at 500 A, voltage at 50 kV, exposure time 500 ms and 200 projections over a 360 rotation.

Set the detector field of view (FoV) to 30722048, number of bed positions to 3 (to cover full PET FoV range), overlap between bed
positions = 30.234713% and detector binning to 4.
 

NOTE: CT reconstruction was performed using cone beam tomography image reconstruction software with HU calibration, bilinear
interpolation and Shepp-Logan filter.

3. 18 F-FDG:
1. Order sufficient 18F-FDG (for example 450 MBq in 0.5 mL) from a local provider to arrive ~ 30 min before the first injection. Aliquot and

dilute the 18F-FDG so that animals receive ~ 10 MBq of 18F-FDG in a final volume of 0.1 mL.

3. Imaging Protocol

1. Wipe down induction chamber and imaging bed with 80% (v/v) ethanol to maintain aseptic conditions. Place the mouse in an induction
chamber and anesthetize with 5% isoflurane in oxygen.

2. Place the mouse onto an imaging bed fitted with an electric heating pad to maintain body temperature and a precision vaporizer nose cone
to deliver isoflurane (maintenance, 1.5 - 2%) at a flow rate of 1 L/min. Apply ophthalmic ointment onto eyes to prevent dryness whilst under
anesthesia.

3. Position the mouse in a prone position on a sensor pad to monitor breathing and ensure an adequate plane of anesthesia is maintained.
4. Warm the tail using a heat pack for 1 - 2 min to dilate the lateral tail vein. Catheterize the lateral tail vein by inserting a 30-gauge needle into

the lateral tail vein. Secure the needle in place with surgical glue and secure the catheter.
5. Load imaging bed into the scanner and move the bed through the machine so that the catheter can be accessed from the rear of the

machine.
6. Attach the catheter to the 18F-FDG syringe in a syringe driver. Calculate the exact 18F-FDG dose (10 MBq) based on activity in syringe before

injection and the volume to be administered (< 100 μL, injected over 10 s).
7. To minimize the impact of anesthesia on variability of glucose uptake, ensure a constant time between induction of anesthesia and injection of

18F-FDG (for example, 30 min).
8. Commence the PET scan immediately before injection of 18F-FDG. After finishing the PET scan (3,600 s), perform a CT scan (~ 10 min) to

allow for co-registration of radiotracer uptake with tissues.
9. Move the imaging bed to the starting position, remove the animal from the bed.
10. At this point euthanize the animal or allow it to recover:

1. For euthanasia, perform cervical dislocation whilst still under anesthesia and collect organs of interest for subsequent analysis.
2. If allowing the mouse to recover, place the mouse in single housing on a heating pad or in front of a heating lamp. Monitor the mouse

until it has regained sufficient consciousness to maintain sternal recumbency. Allow the mouse to recover for 1 h before returning to
group housing.

4. PET Image Processing

NOTE: Image reconstruction was performed using acquisition workplace software v1.5.0.28 and analysis in research workplace software v4.2.

1. Co-register CT and PET images and ensure that the alignment is correct in all 3 dimensions.
1. In the 'File' menu, select 'Folder Search/Import' and select the folder containing the data. Select the desired PET and CT data and click

on the 'General Analysis' tab.
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2. Sort the data so that the CR is designated 'Source' and PET is designated 'Target'. In the 'Workflow' menu, select 'Registration'. If the
images require adjustment to be correctly co-registered, use the tools in the 'Registration' menu.

2. In the 'Workflow' menu, select 'ROI Quantification'.
1. Use the 'Pan' and 'Zoom' functions in the 'Image' tab to locate the desired region. In the 'Tools' menu, select the 'Create' tab and click

the paintbrush icon. Draw the ROI on the image

3. Extract time-activity curves by selecting 'Save ROI Quantification' from the 'Save' menu. Save the data as a CSV file.
4. Quantify radioactivity uptake as Bq per cm3 of tissue. Convert values into percentage of injected dose per cm3 (% ID/ cm3) by loading the

CSV file into a spreadsheet.

5. Input Function

1. To correct for the system point spread function, deconvolve the estimated system PSF for 5 iterations using the reblurred Van Cittert
deconvolution method as previously described9.
 

NOTE: This is required due to the small size of the vena cava in a mouse.
2. Use post deconvolution images to generate a blood input function time-activity curve as described above.

6. Kinetic Modeling

NOTE: The FDG two-tissue compartment model (Figure 1) requires the plasma input function.

1. Convert the blood input function in the CSV file to the plasma input function using the following equation10: Input_plasma = Input_blood ×
(0.386e−0.191t + 1.165).

2. In the kinetic modelling tool click the 'Kinetic' button. Import the tissue and plasma total activity count CSV files into the kinetic modelling tool
by selecting 'Load Time Activity Curve' from the 'Menu'.

3. In the 'Model' menu select 2 tissue compartments. Ensure that the box next to k4 is unselected and enter a value of 0. For initial fitting,
uncheck the box for vB (blood volume fraction) and enter a value of 2%.

4. Click the 'Fit current region'. Correct the extracted region of interest for dispersion11,12. Achieve this by minimizing the Chi-square value for the
FDG model for different dispersion times.

5. Perform a second fit using floating vB value (check the box next to the box for vB) and the optimized dispersion value to calculate the regional
rate constants (k1-k3). Calculate the regional influx constant as Ki = (k1 × k3) / (k2 + k3).

Representative Results

We have previously used the db/db mouse model to investigate the impact of increasing plasma apoA-I levels on the kinetics of glucose uptake
and metabolism13. In this study we used db/db mice treated with insulin to demonstrate the utility of PET/CT imaging to monitor the uptake of 18F-
FDG from the plasma into the gastrocnemius muscle in real time.

Six week old db/db mice were anesthetized and treated with 3 U human insulin/kg, or equivalent volume PBS via subcutaneous injection 30 min
before the start of the PET scan. Mice received 10 MBq of 18F-FDG via intravenous injection and uptake measured by PET for 60 min. A CT
scan was performed for anatomical reference.

Regions of interest were drawn on the vena cava and gastrocnemius muscle using the CT images (Figure 2). Treatment of db/db mice with
insulin increased the 18F-FDG activity in the gastrocnemius ROI over the acquisition time period (Figure 3A). The values obtained for the vena
cava ROI were converted from blood to plasma values and were not altered by insulin treatment in insulin treated mice relative to control (Figure
3B).

Time activity curves were loaded into the kinetic modelling tool for calculation of kinetic parameters. Data was initially fitted to a two-tissue
compartment method with k4=0 with a Vb (blood volume fraction) value of 2% to calculate dispersion values (80 s and 70 s for PBS and insulin
treated mice, respectively). Fitting was then performed using the above dispersion values and a floating Vb value.

No significant difference in the rate of 18F-FDG transport from the arterial plasma to the intracellular space (k1) or from the intracellular space
to plasma (k2) was observed in insulin treated mice compared to control (Table 1). The rate of 18F-FDG phosphorylation (k3) was significantly
increased in insulin treated mice (7.06 ± 6.60 × 10-3 vs 2.26 ± 0.72 × 10-2 min-1 for PBS and insulin treated groups, respectively; p < 0.05). Insulin
treatment also significantly increased the influx constant (Ki) compared to the PBS-treated animals (5.51 ± 4.25 × 10-4 vs 2.01 ± 0.28 × 10-3 mL
min-1 g-1, respectively; p < 0.05).
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Figure 1: Regional time-activity curves were fitted to a two-tissue, three compartment model, with C1 being the concentration of FDG in plasma
and C2 and C3 the concentration of FDG and phosphorylated FDG in tissue, respectively. k1 represents the FDG uptake rate in tissue, k2 the
clearance rate from the tissue back to the plasma compartment and k3 the phosphorylation rate of FDG. The dephosphorylation of FDG was
assumed to be negligible (k4=0).

 

Figure 2: Example of drawing of regions of interest in gastrocnemius muscle (A) and vena cava (B) on a co-registered PET-CT image. Please
click here to view a larger version of this figure.
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Figure 3: Time-activity curves for regions of interest in gastrocnemius muscle (A) and vena cava (B). Male db/db mice were fasted for 4.5 h prior
to receiving 3 U/kg insulin (red) or equivalent volume PBS (black). 18F-FDG (10 MBq) was delivered via intravenous injection and 18F-FDG levels
in the gastrocnemius muscle and vena cava determined by PET/CT for 60 min. Values are mean ± SD and expressed as percentage of injected
dose, calculated from a full field of view (n=4/group). Modified from Cochran et al. 13 Please click here to view a larger version of this figure.

k1 k2 k3 KiTreatment

(mL min-1 g-1) (min-1) (min-1) (mL min-1 g-1)

PBS 1.31±0.42×10-2 0.12±0.11 7.06±6.60×10-3 5.51±4.25×10-4

Insulin 1.45±0.59×10-2 0.09±0.05 2.26±0.72×10-2 * 2.01±0.28×10-3 *

Table 1: Kinetic analysis of increased 18F-FDG from plasma to gastrocnemius muscle in insulin treated db/db mice. Values are mean ± SD.
*p<0.05 vs PBS according to a Mann-Whitney test (n=4/group).

Discussion

The protocol described here represents a robust, non-invasive methodology to determine the kinetics of glucose uptake from the blood stream
into tissue and subsequent metabolism in mice.

The db/db mouse is a is a well-established animal model of type 2 diabetes14 that has been used extensively to examine insulin resistance and
relevant interventions. However, previous studies have only quantified endpoint uptake in the heart15 and cardiac and skeletal muscle16.

The use of kinetic analysis to determine physiological rate constants and model the uptake of 18F-FDG from plasma into tissue allows for insights
into the impact of antidiabetic treatments on glucose uptake and metabolism. In addition, these experiments can be performed longitudinally to
assess, for example, the impact of age or diet on glucose metabolism. This is advantageous over traditional methods that require euthanasia and
collection of organs of interest and thus provide information only at a single time point.

Whilst input functions have previously been determined using the whole heart17 as well as heart, liver and a blood samples18 in mice, the
protocol described here permits calculation of the input function using a region of interest over the vena cava19. It is also possible to calculate
input functions using arterial blood samples during a PET study. However, this is impractical due to the small blood volume of mice.

The use of a plasma input function rather than the 18F-FDGsignal in whole blood is due to the uptake of 18F-FDG into mouse red blood cells20.
Furthermore, the red blood cell associated activity represents 18F-FDG inside red cells, and hence is not readily available for transport into other
tissue compartments.

In this protocol, it is critical to ensure correct placement of the catheter placed into the tail vein for delivery of the 18F-FDG bolus to the vena cava
and throughout the body of the mouse. Warming of the tail to dilate the tail vein significantly improves the ease of inserting this catheter. It is also

https://www.jove.com
https://www.jove.com
https://www.jove.com
http://ecsource.jove.com/files/ftp_upload/55184/55184fig3large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2017  Journal of Visualized Experiments May 2017 |  123  | e55184 | Page 6 of 6

important to ensure that the PET and CT images are properly coregistered so that the ROIs drawn on the CT image correctly correspond to the
PET signal.

There is some debate over the choice of anesthetic agent in studies examining glucose uptake. Whilst isoflurane is a commonly used veterinary
anesthetic, the use of sevoflurane may be advantageous in 18F-FDG PET experiments21. In this protocol, it is important to ensure that any
potential bias associated with isoflurane anesthesia is minimized by keeping the time between induction of anesthesia and the commencement
of imaging constant.
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